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Introduction 
General 

Contact Center Modules (CCM) provides the user with the necessary tools to facilitate the 
management of call traffic. They are designed to provide a tightly integrated real time and 
historic reporting package and wallboard support for the eBusiness digital communications 
platform. The product consists of a set of fully integrated modules sharing a common database 
utilizing Interactive Directory and Database (IDD) technology. 

The suite of modules consists of the following applications: 

Call Center View (CCV):  
 Provides a management package for telephone based staff and supports any size 

Customer Facing Department (CFD) or contact center. To effectively control customer 
service levels, real time human resource management is essential and the Call Center View 
has been specially designed to manage the CFD’s or contact center’s most valuable and 
expensive asset – it's people. 

Call Center View Alarm Reporter:  
 Provides information (for each Call Center Profile) about alarms that have occurred within 

the contact center. The detailed alarm information for each directory number is presented in 
report format, which can then be printed. 

Wallboard Manager:  
 Real time information from the contact centre is essential to react to constantly changing 

telephone traffic levels and provide excellent customer service. Wallboards allow managers 
and staff to monitor the service being provided and respond immediately. Wallboards 
provide current information on the number of calls waiting, response times and service 
levels. Wallboard Manager provides the ability to drive Ferrograph physical wallboards and 
PC wallboards. 

PC Wallboard:  
 The PC Wallboard delivers traditional wall mounted wallboard functionality to the desktop 

but with the additional benefit of each PC Wallboard agent being able to configure and 
monitor a personalized view of the contact center. The PC Wallboard also enables agents 
to increase their productivity and maintain revenue levels with the added benefit of 
managing customer callback requests. 

Report Manager:  
 Provides in depth historical reporting on CFD or contact center activity. In addition to call 

information, the Report Manager also reports agent activity. This powerful package allows 
individual call records to be stored and reported upon months later.  

Workforce Management – Blue Pumpkin:  
 Workforce Management Interface allows integrated rostering, forecasting and scheduling 

systems to connect across the LAN to a comma separated variable (CSV) file containing a 
list of contact center related metrics. 

Multimedia Module:  
 MultiMedia Module (MMM), is a customer contact software solutions that enables 

companies and departments to manage multimedia contacts into and out of the 
organization. MMM provides applications that manage Web Chat, E-mail and Web Call 
Back communications. For installation of MultiMedia Module, refer to the separate 
Installation Manual. 

Report Designer:  
 The Report Designer is a separate product that can be used in conjunction with Report 

Manager and is a software tool used for querying and reporting. It enables the user to 
create reports that contain data from their contact center database and schedule reports to 
be updated and printed.  It is installed when Report Client is installed but requires a licence 
to operate.  

INDeX Taskbar: 
 Enforces the user rights and password protection as well as providing a single point of 

access to the Contact Center Modules. 



Introduction INDeX Wallboard Manager - Page 4 

CCM 4.0 Wallboard Manager Introduction - Page 4 
38HBK00001SCA Issue 8 (06/06/2003) INDeX Wallboard Manager 

INDeX Wallboard Manager 
Wallboard Manager provides the user with the ability to monitor, in real time, the service being 
provided to customers and display information on customer service metrics such as number of 
calls waiting, waiting call queue length and Service levels. 

The Wallboard Manager application comprises of the following elements: 
• Wallboard Server 
• Wallboard Client (Maximum 19) 
• PC Wallboard (Maximum 250 – dependent upon the number of purchased licenses) 
• Physical Wallboards (Maximum 30) in total. 
 

The Wallboard Server & Client applications use a wizard. A wizard is a series of presentations, 
displayed in a secondary window, which guides you through the application. Simply follow the 
instructions on each screen, selecting your required options. 

 

INDex Wallboard Server 
This enables a maximum of 20 users to add, edit and delete Wallboard messages from 
Wallboard message library. It also provides a sophisticated scheduling wizard to display 
Wallboard messages. 

The Wallboard Server enables you to display messages on to a Wallboard device which could 
be a wall mounted Wallboard or the PC Wallboard. 

A message can be created in two formats: 
• text only message. 
or 

• text incorporating Variable Data. 
Variable Data is information received from the telephone system (e.g. Number of Calls Waiting). 

Each message has to be scheduled accordingly, to be displayed on to a Wallboard device. A 
message can be scheduled to be sent immediately or at a predefined time or date. Supervisors 
may select a message and send it to a single, several or all Wallboard devices. 

The Wallboard Server application also enables you to compile alarm messages, which can be 
accessible from other applications, e.g. Call Center View. 

Up to 30 different Wallboards or 250 PC Wallboards can be connected to the PC hosting the 
Wallboard Server application. These devices are installed and configured individually. 
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INDeX Wallboard Client 
Using the Wallboard Client you have full access to the message database as well as the ability 
to schedule your required message to the Wallboard media of your choice (ie. Wallboard or the 
PC Wallboard). 

 Wallboard Client does not support the following features: 
• Add, Edit and Delete Alarm Messages 
• Format Alarm Messages 
• Add and configure Wallboard Devices 
 

INDeX PC Wallboard 
The PC Wallboard allows full Wallboard functionality to be displayed on a Windows PC. A 
maximum of 250 PC Wallboards can concurrently be connected to a single Wallboard Server. 

The PC Wallboard operates in two modes: 

• Enhanced (Agent mode). The agent must be logged on to the Telephone system prior to 
invoking the PC Wallboard. The agents log on to the PC Wallboard using their individual 
agent logon ID and the computer name of where the Wallboard server is running. The 
currently logged on agent has the ability to view their own personalized configuration of the 
contact center, consisting of up to 20 contact center variables as well as their assigned 
scheduled messages. 

• Standard User mode. Displaying only the scheduled messages received from the 
Wallboard Server/Client applications. In this mode you logon to the PC Wallboard using 
only alphanumeric text and the name of the server where the Wallboard is running. 

 

INDeX Taskbar 
INDeX Taskbar provides the ability to launch the INDeX CCM applications.  It also provides built 
in security through a logon procedure; i.e. you must log on to the INDeX Taskbar before 
launching the INDeX CCM. Further details on the INDeX Taskbar are availiable from the INDeX 
Taskbar User Manual. 
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Wallboard Server 
Starting the Wallboard Server 

Before starting the INDeX Wallboard Server, you must ensure that the Delta Server is running 
and that you have logged on to the INDeX Taskbar. 

The Wallboard Server can be launched by clicking the Wallboard Server icon in the INDeX 
Taskbar.  You can also start the Wallboard Server by following the procedure below. 

1. Click the Start button on the Windows taskbar. 
2. Point to Programs and then INDeX CCM. 
3. Select Wallboard Server from the sub-menu. 
 
The Wallboard Server will automatically connect to the last known Delta Server if you are not 
using the Wallboard Server for the first time, and in the splash screen, the Reconnect to last 
known Delta Server option is selected. If you are using the Wallboard Server for the first time, or 
if in the splash screen, the Reconnect to last known Delta Server option is not selected, then 
the Search screen appears indicating the Wallboard Server is searching for the Delta Server(s). 
Once the Delta Server(s) have been located the Find Server screen appears. 

1. Select the required Delta Server, then click the Connect button. 
2. If your required Delta Server is not listed, click the Advanced button then: 
3. Select one of the options of where to search for the server. 
4. Click the Search button. 
5. From the listed Delta Server(s), select the required server. 
6. Click the Connect button. 

Note: Every time you start and/or exit the Wallboard Server, the internal buzzer within the 
Wallboard is triggered whilst resetting the Wallboard device(s). 

 

Check Wallboard Operation 
Once you have started the Wallboard server, you can check the Wallboards that you are 
connected to. 
1. From the Devices menu select Wallboard Properties. 
2. The list of available Wallboards is shown. If no Wallboards show, you will need to install a 

Wallboard. 
 
To check a Wallboard: 
1. Select the Wallboard to check from the listing. 
2. Click on the Properties button. 
3. Click on the Hardware tab. 
4. Click the Self Test OFF button to start the self-test. A message will show asking 'The self 

test will clear any messages on the selected wallboard. Do you wish to continue? Click on 
the Yes button if there are no messages running. 

5. If information appears on the selected Wallboard, click on the Self test ON button to turn 
the test off. 

6. Click the Cancel button. 
7. Click the Close button. 
 

View Active PC Wallboard 
When this option is selected, you will see a list of PC Wallboard(s) currently connected to the 
Wallboard Server. To update the list, click Refresh. 
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Schedule List 
Once scheduled, messages appear on the message schedule list. This allows the supervisors 
to quickly view, which messages are currently, being sent and which are scheduled to be sent 
to the Wallboard devices. A total number of 100 messages can be scheduled. The Schedule 
List displays the following criteria: 

Status: Shows if message is active or inactive. 
Active indicates the Scheduled Message is being displayed on the Wallboard device, 

however this depends upon the priority level of the message. 
Inactive indicates the Scheduled Message is not currently displayed on the Wallboard 

device. 
Message: The text of the message to be sent including variables. 
Client: The name of the machine which has scheduled the message. 
User: The name of the user who has scheduled the message. 
Priority: Shows the priority of the message (1-9). 
Start Date: The date at which the message will be sent to the Wallboard. 
Start Time: The time at which the message will be sent to the Wallboard. 
Duration: The duration for which the message will appear on the Wallboard. 
Delay: The delay between the message being removed and redisplayed. 
Repeat: The number of times the message is to be repeated. 
Device: The Wallboard device type to which the message is to be sent. 
Unit: The address of the Wallboard to which the message is to be sent. 
Port: The Comms port to which the Wallboard is attached. 
Variable 1; Variable 2; Variable 3; Variable 4; Variable 5; Variable 6: The variable type 

assigned within a message (e.g. calls waiting). 
DN:1; DN:2; DN:3: The directory number(s) on which the variable will report (e.g. Agent 4444). 
Alpha Tag: The name of the Wallboard device. 
Display Zero Values: Shows zero values for any selected variable. 
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Administering Messages 
Overview of Administering Messages 

This section details the procedures required to add, edit and delete messages; create, edit and 
delete a customized variables, and schedule messages. 

Wizards are used to help you set your options. To use a Wizard just follow the instructions on 
the screen, selecting your required options. Command buttons on each wizard screen are: 

Back To redefine any of your setup options. 
Next To proceed to the next step. 
Cancel To close the screen without making any changes. 
Update To complete and save your message. 
Finish To end the wizard. 

 

Wizard screen toolbar buttons are provided with ToolTips. To review the function of a toolbar 
button, move the cursor over it. A message appears describing the button's function. 

 

Create a Message 
This section details the procedure to create a message, include it in the Message Library and 
show it on the Wallboard. To create a new message: 

1. Click  from the Wallboard Server main screen. 
2. Select Add Message. 
3. Click the Next button to proceed. 
4. Select the format of the characters and the color of the message. See page 9 for more 

information on formatting messages. 
5. Type in your message and select any variable data. If the message showing in the Message 

preview area is correct, click on the Update button. See page 11 for more information on 
variable data. 

6. Select Schedule Message. 
7. Click the Next button to proceed. 
8. Select the message you have just created and then click on the Next button. 
9. Specify the starting date and time. For more information, refer to page 15. 
10. Click the Next button to proceed. 
11. Select the Priority level. Refer to page 16 for more information. 
12. Click the Next button to proceed. 
13. If your message contains variable data, you will have to opportunity to select the directory 

numbers. Detailed information about this option is given on page 17. 
14. Click the Next button to proceed. 
15. Select the target Wallboard. Page 17 contains details on selecting different Wallboards and 

PC Wallboards. 
16. Click the Finish button. 
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Format Messages 
Formatting must be selected BEFORE typing a message. 

When writing a message (Max 100 characters), you can apply character formats to the text (e.g. 
bold or top line, etc.) by using the buttons. 

You can specify whether to display text on the top line or bottom line (single height), or double 
height of a Wallboard device. It is possible to display two (single height) messages at once. 

 

Format Characters (10/22 Wallboards) 
To format the characters, click the option(s) as required i.e.: 

 - Bold,  - Flashing,  - Inverse 

Note: It is not possible to format a single word as these features affect the whole message 
The following table details the number of characters that it is possible to display on 
Wallboard devices when using certain formats. 

 
Line Bold Inverse Flashing Characters 
Top Off Off Off 22 Characters 

 On Off Off 11 Characters 
 On On On 11 Characters 
 On On Off 11 Characters 
 Off Off On 22 Characters 
 Off Off On 22 Characters 
 Off On Off 22 Characters 

Bottom Off Off Off 22 Characters 
 On Off Off 11 Characters 
 On On Off 11 Characters 
 On On On 11 Characters 
 Off On Off 22 Characters 
 Off On On 22 Characters 
 Off On On 22 Characters 

Top & Bottom Off Off Off 22 Characters 
 On Off Off 11 Characters 
 On Off Off 11 Characters 
 On On Off 11 Characters 
 On On On 11 Characters 
 Off On Off 22 Characters 
 Off On On 22 Characters 

Double Off Off Off 11 Characters 
 On Off Off 5 Characters 
 On Off On 5 Characters 
 On On On 5 Characters 
 Off On Off 11 Characters 
 Off On On 11 Characters 
 Off Off On 11 Characters 
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Control the Display Line 
To alter the display line of text, click: 

 Top line - By default this option is selected 

or 

 Bottom Line 
or 

 Double Height 
 

Message Display Setup 
You can also specify the color as well as the display features (i.e. how the message appears 
and disappears from the Wallboard device) of the characters on the Wallboard device. These 
features must be selected prior to typing the text. 

• Click  to change the color as well as the display features of the characters on the 
Wallboard device. 
• To change the color, click any of the color options. 

• To change the visual effect of the characters (i.e. Display Features) as they Appear on the 
Wallboard device, click the pull down arrow for the available options. Select the required 
feature. 

• To change the visual effect of the characters on a 10/22 Wallboard (i.e. Display Features) 
as they Disappear, click the pull down arrow for the available options. Select the required 
feature. 

• When finished, click OK. 
• To close the screen without making any changes click Cancel. 
Note: Some of the Appear Features will not be displayed on the Wallboard devices correctly 

due to text formatting, e.g. Uppercase letters, Bold, Double Height, etc. 
 

Buzzer - This will trigger the internal buzzer whilst the message is being displayed on 
Wallboard device(s). 

 Relay - This will trigger the external device(s) (e.g. light) whilst the message is being 
displayed on the Wallboard device(s).  

 

Pause Message (10/22 Wallboards only) 
This option creates a delay of 2 seconds between scrolling messages. This feature is only 
valid for messages whose Appear/Disappear features are set to scrolling. If you wish for a delay 
between scrolling messages, then click  associated with Pause. 

 Pause – indicates 2 seconds delay between scrolling messages 

 Pause – indicates no delay between scrolling messages. (Default setting) 
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Apply Variable Data 
Each message can contain text incorporating Variable Data. Variable Data is directory number 
information received from the telephone system as well as any customized variable that has 
been created in Summary Variables. Refer to page 12 for more information on summary 
variables. 

Up to 6 different types of Variable Data can be associated with a single message. In the 
Message text box and Message Preview the text between { } indicates you have selected 
Variable Data. 

To include Variable Data: 
1. Click the  associated with Variable Data 1. 
2. Select the required option from the list. 

3. Click  to incorporate the variable within the text. 
4. Repeat the procedure for Variable Data 2 and 3 if additional variables are required. 
 

Time and Date 
Time, Date as well as Time and Date can be selected as variable data to be displayed on the 
Wallboard. When you select any of these variables, the Clock icon becomes active. 

If you want to compensate for a different time zone, click the Clock icon . The Time Offset 
screen appears. Select an offset in hours (-12 to 12). 

 

Display Zero Values 
If you do not wish to display Variable Data when the value is zero, then make sure that there is 
not a tick in the box to the left of Display Zero Values in the Wallboard wizard screen. This 
option has no effect on a Scheduled Message with Priority Level 10, as the zero value will 
always be displayed on the Wallboard device(s). 

 Display Zero Values – indicates zero values will be displayed on the Wallboard device; 

 Display Zero Values – indicates zero values will not be displayed on the Wallboard device. 



Administering Messages Create a Message - Page 12 

CCM 4.0 Wallboard Manager Administering Messages - Page 12 
38HBK00001SCA Issue 8 (06/06/2003) Create a Message 

Available Variable Data 
The available Variable Data are: 
Agents Active on Calls: The total number of agents participating on calls. 
Answered All: The total number of all calls (internal and external) answered. 
Answered External: The total number of external calls answered. 
Answered Excluding Transfers - All: The total number of internal and external answered 

calls, excluding transfers. 
Answered Excluding Transfers - External: The total number of external answered calls, 

excluding transfers. 
Average Answer Time All: The average answer time taken to answer all calls today/this shift. 
Average Answer Time External: The average answer time taken to answer external calls 

today/this shift. 
Calls Waiting: The number of calls currently being offered to the group. 
GOS (Grade of Service): The number of calls answered within the target answer time 

expressed as percentage of calls presented. 
Group Activity Status: The current activity of the displayed group. 
Group Calls Answered All: The total number of all internal and external incoming answered 

calls, answered by agents for this group. 
Group Calls Answered External: The total number of external incoming answered calls, 

answered by agents for this group. 
Group Calls Average Duration All: The average duration of all calls answered for a particular 

agent group. 
Longest Waiting Call: The length of the current longest call (5 second update). 
Lost All: The total number of all calls (internal and external) that were lost. 
Lost External: The total number of external calls that were lost. 
Name: The name associated with the directory number as defined by the programming. 
Outgoing All: The total number of calls (internal and external) made today/this shift. 
Outgoing External: The total number of external calls made today/this shift. 
PCA (Percentage Calls Answered): The number of calls answered within the target answer 

time expressed as a percentage of calls (PCA). 
New I/C Presented: The total number of new incoming calls presented today/this shift. 
State: Displays eleven different states: busy, busy not available, busy wrap up, holding, 

incoming logged off, outgoing, ready, ringing, internal made and internal received. These 
can be applied to any applicable device . 

Time: The current time. 
Date: Today’s date. 
Time and Date: The current time and today’s date. 
Number in State - Incoming: The number of agents or trunks currently engaged on incoming 

calls. 
Number in State - Outgoing: The number of agents or trunks currently engaged on outgoing 

calls . 
Number in State - Ready: The number of Agents or Trunks currently available to take calls. 
Number in State - Holding: The number of agents currently holding calls . 
Number in State - Busy-WrapUp: The number of agents currently in Busy Wrap Up. 
Number in State - Busy Not Available: The number of agents currently in Busy Not Available. 
Number in State - Busy: The number of agents or trunks currently busy . 
Number in State - Logged Off: The number of agents currently logged off. 
Number in State - Ringing: The number of agents whose turret is currently ringing. 
Number in State - Internal Made: The number of agents currently on internal made calls . 
Number in State – Internal Received: The number of agents currently on internal received 

calls. 
 

If you have created your own variables, they will also be displayed in the list of available 
Variable Data. See page 13 for how to create variable data. 
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Summary Variable 
The Summary Variable option enables you to create a customized variable. This involves 
assigning any of the Variable Data choices to a multiple number of directory numbers. When 
you create a message the customized variables will show within the variable data list. 

Create 
To create a variable: 
1. From Edit menu, select Summary Variable then Create Variable. The Create Variable 

screen appears. 
2. In the Variable Name text box, type a name for the variable. 
3. Select the Variable Data required using the pull down arrow. 
4. Click the Search DN button to view the Dn Search screen. The Available Dns list box 

contains all the directory numbers within the Telephone system associated with the selected 
Dn Selection categories. 

5. To deselect any of the categories, click a  associated with that category. 
6. To select any of the categories, click a  associated with that category. 
7. Select the required directory number(s) and then click OK. 
8. Click the Save button once you have created the variable 
9. Click the Close button when you have finished creating the required variable(s). 
 

Edit/Delete Variable 
To edit a variable: 
1. From Edit menu, select Summary Variable. 
2. Select Edit/Delete Variable. The Edit/Delete Variable screen appears. The Variable Name 

section displays the created variable(s). When you click a variable, the assigned directory 
numbers will be displayed within the Selected Dns pane. 

 
To change the name of a variable: 
1. Select the required variable. 
2. Click the Rename button. 
3. Enter the required name. 
4. Click on the Ok button when finished. 
 
To remove a variable: 
1. Select the required variable. 
2. Click the Delete button. 
 
To edit a directory number: 
1. Click the directory number to remove. 
2. Click the Remove button. 
 
To add a directory number: 
1. Click the Add button. 
2. Select the directory number required from the DN Search screen. 
3. Click on the Ok button when finished. 
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Edit Message 
Once a message is stored in the library, it can be modified. 

To edit a message: 

1. From the Wallboard Server main screen, click . 
2. Select Edit Message. 
3. Click the Next button to proceed. 
4. Select the required message and then click the Next button to proceed. 
5. Change the formatting if required. (See page 9 for further information). 
6. Change the variable data if required (See page 11 for further information). 
 

Delete Message 
Once a message is stored in the library, it can be deleted if no longer required. 

To delete a message: 

1. From the Wallboard Server main screen, click . 
2. Select Delete Message. 
3. Click the Next button to proceed. 
4. Select the required message. 
5. Click the Delete button. 
6. Once you have completed deleting the required messages, click the Finish button. 
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Scheduling Messages 
General 

When you are scheduling a message you need to consider the following criteria: 
1. When to display the message (immediately or preset date and time); 
2. The duration of the message to be displayed; 
3. How important the message is (i.e. its priority level); 
4. How often to display the message (i.e. only once or repeatedly); 
5. The directory number, if the message incorporates variable data; 
6. Which Wallboard device(s), i.e. Wallboard or the PC Wallboard. 
 

Schedule a Message 
Messages can be scheduled when they are created or later. If you have already created a 
message, you can schedule it by: 

1. Click  from the Wallboard Server main screen. 
2. Select Schedule Message. 
3. Click the Next button. 
4. Select the required message by clicking on it. 
5. Click the Next Button. 
 

Starting Date and Time of Message 
If you want to display the message immediately to a Wallboard device: 

1. Ensure there is a tick next to the option Send the message immediately. 
2. Click the Next button to continue. 
 

To set the date and time for the message to appear on the Wallboard device: 
1. Remove the tick from the option Send the message immediately 
2. Enter the required start Date and Time for the message to be displayed Duration enables 

you to set the length of time that the message will be displayed on a Wallboard device. By 
default, the Duration is set to 10 seconds. 

3. Click the Next button to continue. 
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Priority Level/Repeat Message 
This option enables you to prioritize your message. 

To change the Priority Level: 
1. Click spin button to obtain the required priority number. The priority levels available are 

between 5 and 10. Priority Levels 1–4 are designated for messages received from the Call 
Center View application, see the table shown below. Priority Level 5 can also be utilized to 
schedule a message from the Library Message Database. 

Priority Level Message received from Call Center View 
1 Supervisor Send Message to active PC Wallboard(s) 
2 Critical Alarm threshold 
3 Caution Alarm threshold 
4 Normal Alarm threshold 
5 Standard Send Message to default Wallboard as well as all active 

PC Wallboards 
 
2. Scheduled Messages with priority level 10 will be chained. Chaining allows you to display 

messages on a Wallboard device in sequence. This means that a series of messages can 
be displayed one after the other. When a message is chained, the Start Date, Start Time 
and Delay are adjusted automatically to ensure that the messages are displayed in the 
correct sequence. 

Note: The Schedule List displays the order of when a message was scheduled, so chained 
messages may not be displayed on the Scheduled List in the correct order. The 0 (zero) 
value will always be displayed on the Wallboard device(s) for a Scheduled Message 
with Priority Level 10 (i.e. Chained Message). 

 
To prevent messages repeating: 
1. Select the No option underneath the question Do you want to repeat the scheduled 

message? 
2. Click the Next button to continue. 
 
To repeat messages: 
1. Select the Yes option underneath the question Do you want to repeat the scheduled 

message? 
2. To display the message repeatedly on the Wallboard device, make sure that there is a tick 

in the box next to the question Repeat the message Forever. 
Or 
 To display the message on the Wallboard device only a few times, make sure that there is 

no tick in the box next to the question Repeat the message Forever. 
3. Select the number of times to repeat the message. The maximum number of repeats is 999. 
4. Amend the delay before the message is repeated. By clicking in the section containing 

either the hour, minutes or seconds you can change the value using the spin buttons. 
5. Click the Next button to continue. 
6. Click the Next button to continue. 
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Select Directory Numbers 
This screen appears only if you have selected a message that contains Variable Data using 
directory numbers. If you have not, you will view the Select Wallboard Devices screen as 
detailed on page 17. 

The number of entry boxes depends upon the number of Variable Data (1 - 6) incorporated in 
the message. (i.e. if a message contains only one Variable Data, then one entry box will appear 
in this screen). 

Directory Number for All Variables 
 To monitor the call status of only one directory number for the selected message, then enter 

the required directory number in this text box. The same number is entered automatically in 
the selected variable(s). 

Directory number for Individual Variable 
 To monitor different directory numbers for the selected message, then enter the required 

directory number in each Variable Data entry box.  
 

1. Click  or double click a Variable Data box, the DN Search screen appears. 
2. Click the required Directory Number, then click the OK button or double click the required 

directory number. 
3. Click the Next button to continue. 
 

Select Wallboard Devices 
Wallboard. 

To display messages on a Wallboard: 
1. Make sure that Wallboard is selected 
2. Check that the target is correct. To display the scheduled message on a different Wallboard 

device, click on the Change button to view the Wallboard Server Browser screen. 
3. Select the required Wallboard. If it is not visible, click on any '+' symbols to expand the view 

until the Wallboard required is visible and click on it. 
4. Click the Select button. 
 

To display a message on a PC Wallboard: 
1. Select the PC Wallboard option. A maximum of 250 PC Wallboards can concurrently be 

connected to a single Wallboard Server. 
2. If you know the required directory number, type it in the text box and then click Finish; or 
3. If the required directory number is not known, click Agent ID, DN Search screen appears. 

You can only select Agent(s) and Agent Group(s) from this screen. Select the required 
number and then Click Finish; or 

4. Click Active PC WB and select the required PC Wallboard. Click OK and then click Finish. 

Note: If there are no PC Wallboards listed there are no PC Wallboards logged on. You will 
need to launch the application. 
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Alarm Messages 
General 

Alarm Messages can be created/edited, deleted, and stored in the alarm messages library. 
These messages are accessible from other CCM applications, e.g. Call Center View. 

Note:  Wallboard Client does not support this feature. 
 

When creating/editing an alarm message, the user must ensure the text format, colors and 
effects are distinctive for alarms. 

1. From the File menu, and select Alarm Messages. 
2. To add alarm messages follow the procedures as detailed in "Create a Message" on page 

8. 
3. To Edit alarm messages follow the procedures as detailed "Edit Message" on page 14. 
4. To Delete alarm messages follow the procedures as detailed in Delete Message on page 

14. 
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Alarm Setting 
General 

Alarms received from other applications are classified as Emergency, Alarm and Standard 
alarm types. Their priority level is set within the Wallboard Server application. 

This section enables you to select the text format for each type of received alarm message(s) to 
be displayed on the device(s). 

The Alarm categories are: 

– Emergency: Currently not implemented. 
– Alarm (Critical, Caution, and Normal): Alarms received from the Call Center View 

application. 
– Standard: Standard Send Message received from the Call Center View application. 

Notes:   
1. To display Alarms, you must ensure Forward Alarms has been checked within the Call 

Center View application. 
2. Wallboard Client does not support this feature. 
 

Alarm Message 
When an Alarm message is received from another application, it will be displayed on the 
selected Wallboard device. 

1. From the File menu, select Alarm Setting, then from the Remote Message Properties, 
select Alarm. Click Next and then select the required Wallboard device destination. 

2. Click Next to specify whether to display the message on the top line, bottom line (single 
height), or double height of a Wallboard. 

You can apply character formats to the text (e.g. bold, flashing or inverse). 

You can also change the color of the text to be displayed on the Wallboard device. 

Preview and Color Preview show the format and color of the Alarm Message to be displayed 
on the selected Wallboard device. 

• To format the characters, click any of the option(s) as required i.e.  Bold,  Flashing 

and  Inverse.  
 

• To alter the display line of text, click:  Top line,  Bottom line and  Double 
Height. By default, double height is selected. 

 
• To change the color of the characters on the Wallboard device, click the  pull down arrow 

associated with Color. Select from the listed options. 
 
• To save the settings, click the Finish button. The wizard is rotated to the first Remote 

Message Properties screen. 
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Standard Message 
When a Standard Alarm message is received from another application, it will be displayed on 
the selected Wallboard device. 

1. From the File menu, select Alarm Setting. 
2. From the Remote Message Properties, select Standard. 
3. Click Next and then select the required Wallboard device destination. 
4. Click Next to specify whether to display the message on the top line, bottom line (single 

height), or double height of a Wallboard.  
 
You can apply character formats to the text (e.g. bold, flashing or inverse). 

You can also change the color of the text to be displayed on the Wallboard device. 

Preview and Color Preview show the format and color of the Standard Message, as it will be 
displayed on the selected Wallboard device. 

• To format the characters, click any of the option(s) as required i.e.  Bold,  Flashing 

and  Inverse.  
 

• To alter the display line of text, click:  Top line,  Bottom line and  Double 
Height. By default, double height is selected. 

 
• To change the color of the characters on the Wallboard device, click the pull down arrow 

associated with Color. Select from the listed options. 
 
• To save the settings, click Finish. The wizard is rotated to the first Remote Message 

Properties screen. 
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Template Distribution 
Administrators can create a PC Wallboard profile to send to individual agents, individual groups 
or multiple groups.   

To distribute templates: 

1. From the Edit menu, select Templates and click on Distribute. 
2. A list of agents with saved templates will be shown in a tree format.  Double click on the 

agent to reveal saved-template names.   
3. Select the required template and then click on the 'right' arrow button ( ) to add the 

template to the list of templates to be distributed. 
4. Click on the Destination tab. 
5. Highlight the required agents and/or groups to send the template to and then select the 

'right' arrow button ( ).  The agents and/or groups will show in the right-hand section of the 
form. 

6. Click on the Distribute button to copy the new template to the agent/group of agents 
selected. 

Note:  If the Wallboard server has recently been started, it is possible that it will not show a full 
list of agents/groups.  Update the list by clicking on the Refresh Dns button. 

 

When an agent opens a template that has been sent, all the Dn information is translated to 
make it relevant to that agent as agents are only able to monitor their own Dn. 

The example below shows what would happen if Agent 4321 created a template, and it was 
subsequently loaded by Agent 4200 after being distributed.  Only the Agent Dn settings are 
translated. 

 

 
 

Note:  The 'hot-desking' approach to the PC Wallboard has been maintained by sending all 
available templates to the PC Wallboard on starting up.
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Wallboard Client 
Starting the Wallboard Client 

To start to Wallboard Client: 

1. Ensure that the Delta Server is running. 
2. Ensure that the Wallboard Server is running. 
3. Ensure that you are logged onto the INDeX Taskbar 
4. Click the Start button on the Windows taskbar. 
5. Point to Programs and then the INDeX CCM. 
6. Click Wallboard Client from the sub-menu. 
 
The Wallboard Client will automatically connect to the last known Delta Server if you are not 
using the Wallboard Server for the first time, and in the splash screen, the Reconnect to last 
known Delta Server option is selected. 

If you are using the Wallboard Client for the first time, or if in the splash screen, the Reconnect 
to last known Delta Server option is not selected, then the Search screen appears indicating the 
Wallboard Server is searching for the Delta Server(s). Once the Delta Server(s) have been 
located the Find Server screen appears. 

1. Select the required Delta Server, then click the Connect button. 
2. If your required Delta Server is not listed, click the Advanced button then: 

a) Select one of the options of where to search for the server. 
b) Click the Search button. 
c) From the listed Delta Server(s), select the required server. 

3. Click the Connect button. 
 

Note: The Wallboard Server and a Wallboard Client cannot run on the same PC. 
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Managing Wallboard Client 
Using the Wallboard Client you can: 

• Create customized variable as detailed in "Summary Variable" on page 13; 
• "Create a Message" on page 8; 
• "Edit Message" on page 14; 
• "Delete Message" on page 14; 
• "Schedule a Message" on page 15 : 
• "Delete Scheduled Messages" on page 24; 
• "Refresh Schedule" on page 24; 
• "Find Server" on page 24. 
 
The Scheduled messages are listed on the main Wallboard Client screen. It displays the 
number of Scheduled Messages, their individual status and settings. 

The command buttons on the toolbar are: 

 – Enables you to Add and Schedule Messages 
 

 – Deletes the selected Scheduled Message 
 

 – Receives an update listing of the Scheduled messages from the 
Wallboard Server. It is automatically refreshed every 30 seconds. 

 

 – Searches and lists all available Wallboard Servers to which the 
Wallboard Client may connect. 

 

Schedule List 
The scheduled messages are listed on this screen. A total number of 100 messages can be 
scheduled. For further details see Schedule List on page 7. 

Status Active indicates the Scheduled Message is being displayed on the Wallboard device, 
however this depends upon the priority level of the message. 

Status Inactive indicates the Scheduled Message is currently not displayed on the Wallboard 
device. 
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Menu Bar Options 
• File menu incorporates the following options: 

Messages: Enables you to Add, Edit and Delete Messages; 
Alarm Messages: The Wallboard Client does not support this option; 
Alarm Settings: The Wallboard Client does not support this option; 
Exit: Enables you to exit the Wallboard Client. 

• Edit menu incorporates the following options: 
Summary Variables: Enables you to create a customized variable, assigning any of the 

available variable data to a multiple number of directory numbers; 
Delete Messages: Enables you to delete Scheduled messages. 

• Setup menu incorporates the following options: 
Language: Enables you to select the required language, the Wallboard Client will 

automatically change to the selected language.  

Note: The Wallboard Client does not support Devices menu option. 
 

Delete Scheduled Messages 
Any User may delete messages from the Schedule List where the respective User or lower 
Access Level has scheduled those messages. A User may Not delete messages scheduled by 
peers or Users of a higher Access Level. 

The Delete  button is enabled once you have selected a Scheduled Message. To delete 
Scheduled Message(s), select the message, then click . 

1. Click Yes to Delete the selected scheduled message. 
2. Click No to close the dialog box. 
 

Refresh Schedule 
By default, the Scheduled Messages are updated every 30 seconds. However if there By 
default, the Scheduled Messages are updated every 30 seconds. However if there are more 
than one Wallboard Client connected or there are several Scheduled Messages, then this 
delays the process of updating the Scheduled Message List of every Wallboard Client on the 
network. 

To receive an up to date list of the Scheduled Messages from the Wallboard Server, click 
Refresh Schedule. 

 

Find Server 
This option enables you to connect to a different Wallboard Server. 

1. Click Find Server, and then click No to remain connected to the current Server. 
2. To connect to a different Server, click Yes, and follow step 6 as detailed in Starting the 

Wallboard Client on page 22. 
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PC Wallboard 
General 

 The PC Wallboard allows full Wallboard functionality to be displayed on a Windows PC. 
Messages are scheduled on the PC Wallboard via the Wallboard Server. 

The PC Wallboard operates in two modes: 

• Enhanced Compact Contact Center agent mode.  
 The agent must be logged on to the Telephone system prior to invoking the PC Wallboard. 

The agents log on to the PC Wallboard using their individual agent logon ID. The currently 
logged on agent has the ability to view their own personalized configuration of the contact 
center consisting of up to 20 contact center variables as well as the scheduled messages; 

• Standard User mode: 
 Displaying only the scheduled messages received from the Wallboard Server/Client 

applications. In this mode you logon to the PC Wallboard using an alphanumeric text. 
If the PC Wallboard application is minimized, every time a message of a priority greater than 6 
is in Active status, the message will pop up into the display. 

A maximum of 250 PC Wallboards can concurrently be connected to a single Wallboard Server 
(which must be running to enable PC Wallboard). 

 

Starting PC Wallboard 
Before starting the PC Wallboard, you MUST ensure that the Wallboard Server is running and 
that you have logged on to the Telephone system. Consult your system supervisor concerning 
the Wallboard Server, the name of the PC running the Wallboard Server and your login ID. 

To start the PC Wallboard: 
1. Click the Start button on the Windows taskbar. 
2. Point to Programs and then th INDeX CCM. 
3. Click PC Wallboard from the sub-menu. 
4. Type the Login ID and the name of the PC hosting the Wallboard Server. The Login ID can 

either be: 
• An agent’s directory number (e.g. 5001), enabling you to select and monitor agent’s 

variables; 
• An alphanumeric text (e.g. PCW01); enables you to use the PC Wallboard as a 

display device. In this format, only the Message Display bar will be displayed. 
5. Click Login. A blank PC Wallboard display panel is shown. 
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Menu Bar Options 
File menu incorporates the following options: 

New:  Enables you to select a template. PC Wallboard provides 7 
templates which can be customized and saved as a new 
template; 

Save:  Ensures that changes made to the current user interface are 
saved. 

Save Template as: Enables you to save the current customized template under a 
different name; 

Exit: Enables you to exit the PC Wallboard. 

View menu incorporates the following options: 
Toolbar:  Allows you to toggle between hide or display the Toolbar; 
Status Bar:  Allows you to toggle between hide or display, The Status Bar 

provides information about which directory number is being 
monitored and if the connection is established as well as the 
current data and time; 

Always on Top:  Allows you to toggle between On or Off. If this option is selected, 
the PC Wallboard is always on top of all the other active 
Windows applications; 

Compact:  Allows you to use the PC Wallboard as a display device. You can 
use your right hand button and select Restore, or double click the 
display bar to restore to full screen; 

Callback Requests: Displays a list of Callback Request messages actioned from the 
Call Center View. 

Setup menu incorporates the following options: 
Language: Enables you to select the required language, the PC Wallboard 

will automatically change to the selected language. 
 



PC Wallboard Templates - Page 27 

CCM 4.0 Wallboard Manager PC Wallboard - Page 27 
38HBK00001SCA Issue 8 (06/06/2003) Templates 

Templates 
When you first log in, you are presented with an empty display panel.  

 
You can either 
Use an available pre-set template 
 or  
Customize the blank display panel and create a new template (see Customizing Blank Display 

Fields. on page 28). 
To open a pre-set template: 
1. From File menu select New (or click the icon ) on the toolbar. 
2. Select from the list of pre-set templates and click OK. 
To customize an existing template or create a new template: 
1. Right click, within an existing display field, to display the following options. 

Properties:  
 You will either be presented with the Marquee or General properties menus. 
Variables:  
 When you choose this option you will be able to select the variables that you want to 

view on your PC Wallboard.  
Remove:  
If you select this option, you will remove the selected pane. 

 

Marquee Display Properties 
Right click anywhere on a text display field and select Properties to display the 
Properties/Marquee menu. 

You can change the number of times the message scrolls (if the style is set to Scroll) as well as 
the pause time between each scroll. You can also change background color and the font of the 
message. 

General Display Properties 
Right click anywhere on an LED display field and select Properties to display the 
Properties/General menu. 

You can change the number of LED digits, the decimal size, the number of decimals as well as 
the decimal position. You can also select a different  on, off and/or background color of the LED 
digits. 
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Customizing Blank Display Fields. 
If you right click in a blank display field, you get the following choices. 
Split Pane: 

Horizontally – New pane on Top or Bottom. 
Vertically – New Pane on Left or Right.  

Remove Pane: Removes the selected pane. 
Display Setup Wizard: This option invokes the wizard to select the agent’s variable. 
 

Display Setup Wizard 
Display Setup Wizard enables you to configure the selected panel to display the variable data 
for the current logged on directory number. The panel can be configured to display up to 20 
variable data fields. 

To configure a blank display field: 
1. Click the right hand mouse button on a blank display field and from the available menu 

options, select Display Setup Wizard. 
2. The available field options are: 

 Marquee: Displays a horizontally scrolling text message; 
 LED: Displays the message in digital layout. 
Select the required field. 

3. Click Next to proceed to select the required Variable. 
 From the pull down list, select one of the variables, e.g. Answered All, Calls Waiting, etc. 
4. Select (put a tick in the box) as required from the following options: 

Popup if Value Changes:  
 If the PC Wallboard is minimized, when the value of a variable changes, then this will 

cause the PC Wallboard screen to pop-up (i.e. maximize) with the variable value 
flashing. 

Maximize Message Bar:  
 When the PC Wallboard is running in ‘compact mode,’ i.e. with only the Message Bar 

being displayed, then, when the value of a variable changes, this will cause the PC 
Wallboard screen to pop-up (i.e. restore) with the variable value flashing. 

5. Click Refresh to ensure all the available directory numbers are listed. Click Next to select 
the required directory number. 

6. Select the position of a label if one is required; modify the label message as required and 
then click Finish. 
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Callback Request Messages 
When you receive a Callback Request message from the Call Center View, the Callback 
Request button on the toolbar flashes . Click the button and the Callback Requests screen 
appears, listing the Callback Request message(s). 

You must enter the Digit(s) required for accessing the outside line. This number is configured 
within the telephone system. 

The Callback Request command buttons are: 

 Make Callback: Click a callback message and then click Make Callback to make the 
call. 

 Callback Succeeded : If the called party is the intended recipient, then during the call, 
click Callback Succeeded. This is for historic report purposes to indicate the callback was 
successful. Further details are available from the Agent Callback Request Report. 

 Callback Failed : If the called party is not the intended recipient, the line was busy or 
no answer, then during the call, click Callback Failed. This is for historic report purposes to 
indicate the callback was not successful. Further details are available from the Agent Callback 
Request Report. 

 Clear Callback : When you have finished with the call, you must click Clear Callback 
to inform the Contact Center View Supervisor you have responded to the callback message. 
Cleared will be displayed in the Callback Request screen within the Contact Center View 
application. 

 

The information on the screen is: 

Information Description 
CLI Number to call 
Time Time the callback Request message was sent from CCV 
Date Date the callback Request message was sent from CCV 
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Display Field/Message Bar Properties 
Embedded with every selected Display Field as well as the Message Bar, there is a Properties 
screen. This also applies to the Label of the Display Field. Using the Properties option, you can 
customize the look and feel of the selected section. 

 

Message Display Bar Properties 
Right click (using right hand mouse button) anywhere on the Message Display Bar and select 
Properties from the available commands, the Properties screen appears. 

Configure the required features. 

You can change the number of times the message scrolls as well as the pause time between 
each scroll. You can also change the background color together with the font of the message. 

 

Marquee Display Properties 
Right click (using right hand mouse button) anywhere on the Display Field (Marquee) and select 
Properties from the available commands, the Properties screen appears. 

Configure the required features. 

You can change the number of times the message scrolls (if the style is set to Scroll) as well as 
the pause time between each scroll. You can also change background color and the font of the 
message. 

 

LED Display Properties 
Right click (using right hand mouse button) anywhere on the Display Field and select 
Properties from the available commands, the Properties screen appears. 

Configure the required features. 

You can change the number of digits, the decimal size, the number of decimals as well as the 
decimal position. You can also select a different background color and the color of the digits. 
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